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Disclaimer

The computer program described in this document is available with the understanding
that the U.S. Department of Agriculture cannot assure its accuracy, compieteness,
reliability, or suitability for any purposes other than that reported. The recipient may not
assert any proprietary rights thereto or represent it {o anyone as other than a
Government-produced computer program.

The use of trade. firm, or corporation names in this publication is for the information and
convenience of the reader Such use does not constitute an official endorsement or approval by
the U S. Department of Agriculture or the Forest Service of any product or service o the exciusion
of others that may be suitable.



Abstract

The user's manual describes the use of the NEWILD computer program. NEWILD is software
develcped by the U S. Dapartment of Agriculture, Northeastern Forest Experiment Station as part
of the NED proect, an ongeing effort to deveiop software toois to support Ecosystem
Management decision maxing. NEWILD can be used to determine which of the 338 species of
verebrales in New England may be found in particular habitats, or which habitats are preferred or
utiized by a particular species of wildlife. The object of this program is to assist in the access and
svaiuation of the information presentsd in the Species/Habitat matrices developed by Richard
DeGraaf, Deborah Rudis, Mariko Yamasald, William Leak, and John Lanier (GTR-NE-108, GTR-
NE-144). Some of the text from these publications have been incorporated into the hyperiext
portion of tns program. NEWILD was designed for use in conjunction with these publications. A
diskette containing the NEWILD program is included with this manual. The program requires
Windows 3.1 or iater to operate.
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SECTION 1 OVERVIEW

1.1 What You Need to Read
Regardless of your computer experience, you should at least browse the following sections in the
User's Manual.

e Section 1 OVERVIEW

e Section2 INSTALLATION

¢ Section 3 RUNNING NEWILD

1.2 Purpose of NEWILD

NEWILD is designed to assist in the access and evaluation of Species/Habitat matrices
developed by Richard DeGraaf, Deborah Rudis, Mariko Yamasaki, William Leak, and John
Lanier. The matrices are presented in two publications:

DeGraaf, R. M.; Rudis, D. D. 1986. New England wildlife: habitat, naturat history, and
distribution. Gen. Tech. Rep. NE-108. Broomall, PA: U.S. Department of Agriculture, Forest
Service, Northeastern Forest Experiment Station. 491 p.

Gives natura! history profiles of New England wildlife species and their associations with
forested and nonforested habitats. Provides a data base that will enable forest managers
or wildlife biologists to describe the species or groups to be found in a given habitat.

DeGraaf, R. M.; Yamasaki, M.; Leak, W. B.; Lanier, J. W. 1992. New England wildlife:
management of forested habitats. Gen. Tech. Rep. NE-144. Radnor, PA: U.S. Department
of Agriculture, Forest Service, Northeastern Forest Experiment Station. 271 p.

Presents silvicuitural treatments for six major cover-type groups in New England to
produce stand conditions that provide habitat opportunities for a wide range of wildlife
species. Includes matrices for species occurrence and utilization by forested and
nonforested habitats, habitat bread.n and size class, and structural habitat features for the
338 wildiife species in New England.

Throughout this manual they will be referred to as GTR-NE-108 and GTR-NE-144. While' we have
incorporated some of the text from GTR-NE-108 and GTR-NE-144 into the HELP portion of this
program, it appears in an abbreviated form. We urge the user to refer to the publications for a
fuller explanation.

1.3 The Relationship of NEWILD to NED

NEWILD is one of several computer programs designed to support good forest stewardship. The
full set of tools is known coflectively as NED, a computer-based, decision-support system being
developed by the U.S. Department of Agriculture, Forest Service, northeastern Forest Experiment
Station. NED provides site-specific analyses of management alternatives and expett
recommendations to improve management for multiple values on forests in the Northeastern
United States. These recommendations are based on a range of resource values including
wildlife habitat, visual qualities, and watershed and ecological characteristics, as well as traditional
timber and economic values. This is accomplished by incorporating knowledge from many
resource experts into the decision-support systemn. That knowledge is used with inventory data
describing the present state of a forest management unit to buitd prescriptions for managing the
forest to meet user's goals. NEWILD is the result of an initial effort to codity expert knowiedge
about wildiife habitat reguirements in the Northeast.



1.4 Who Should Use NEWILD

NEWILD is intended for use by a wide range of individuals and organizations, including wildiife
biclogists, consulting foresters, national and state forestry organizations, forest industries, private
organizations and individuais, and educational groups. The program enabies the user to assess
the potential effects of proposed habitat management practices on wildlife species. It also aids in
developing and evaluating resource management pianning alternatives.

1.5 Application of information

NEWILD can be used to explore the pofential responses of amphibians, reptiles, birds, and
mammals to hebitat alterations introduced through forest management in New England.
Nevertheless, tnere is no substitute for sound fieid work and judgment in assessing the impacts of
a specific project or proposed management action. The habitat associations provided here are
essentially a set of hypotheses that can and should be tested further. Thus, we hope that this
program will also be used to help identify areas of study for validation of the information contained
here. The information in this publication is most useful for land management and project pianning.
The larger the unit considered, the more accurately the species occurrence can be predicted.
This is because large areas will likely contain more of the special habitat requirements, more
edges due to the interspersion of habitats, and more successional stages, hence more species.
Conversely, the smaller (more site-specific) an area, the less accurate will be assumptions or
predictions of species occurrence, and the greater the need for biclogical experience and detailed
field work. Application of this process to areas outside New England is an important goal for our
work, and considerable testing and modification of the content are likely before the program can
provide reliable information for a wider geographic area.

1.6 Accuracy of Information

The information presented in the program is a first effort to assemble natural history and habitat
associations to enable sound management of New England wildiife. The data base needs o be
expanded to include other nonforested habitats, and field checking would improve the accuracy of
entries. These limitations point to some cautions:

e The information presented in this program is not a substitute for professional field work, nor for
thoroughly checking each site proposed for management. At the very least, managers need
field information on the special habitat requirements present or lacking on each site proposed
for management.

e The information presented in this program lists the species potentialfy occurring in a given
habitat. More are listed than will likely occur - the smaller the site, the fewer the species that
will actually occur. Factors other than habitat features affect a given species occurrence in an
area. This effect diminishes with increasing area of consideration. Still, several site visits will
be required to determine whether a given species actually occurs on a given site.

¢ No information is included on habitat size. The best clue to help determine whether a given
species will occur, after checking whether its special habitat requirements are present, is to
compare its territory or home-range size with that of the proposed project. No detailed
information, therefcre, is provided here on how many of a given species will occur in an area.
Dividing the project area by the territory/home range area of a species is not recommended,
because not all parts of 3 habitat patch will be occupied, and density will be overestimated.
We have provided sampie densities when such information was reported. Note localities
when consulling these entries.



1.7 Technical Support (Getting Help)
To make NEWILD easier to use, several help options are available.

e Read through “RUNNING NEWILD" in Section 3. This will introduce you to many of the program
features.
e Read this User's Manual and keep it handy as a reference as you begin to use the program.
e Try to find an example that fits your needs. A number of examples that demonstrate the use of
the program are shown in Section 4 EXAMPLES ‘
¢ Read over Section 5 FREQUENTLY ASKED QUESTIONS.
~* Look through the README.DOC file included on the distribution diskette. It will include any last
minute updates to the program that may not be included in the User's Manual.
e Finally, if the sources above do not answer your questions, we will be glad to help you through
any problem you may have with the program. Please contact:
USDA Forest Service
Northeastern Forest Experiment Station
705 Spear Street, PO Box 968
Burlington, VT 05402-0968
Telephone: 802-851-6774
Fax: 802-951-6368

1.8 Typographical Conventions
Throughout the User's Manual, special notation is used to represent certain keystrokes. In
general, a key name within a square identifies a key that should be pressed. For example:
fenee = press the "ENTER" key
7] = press the "F1" function key
AT} = press the "Alt" key
[¥] = press the "F" key
Occasionally the program requires you to press a key combination or sequence of keys. The
following examples explain the difference.
[ALT] +[F] hold down the [AlT] key while pressing the [} key.
T&T} , [F] press and release each of these keys in order.

The following conventions are used throughout the User's Manual
e« File names are typed in uppercase, using a special font. For example: README . DOC
e User-entered commands are shown in bold face text.
e ltems from the pull-down menu bar are in Bold face with the hot-key underlined.
e Items within a pull-down menu are in “Regular” face, enclosed in quotes with the hot-key
underlined.



SECTION 2 INSTALLATION

2.1 System Requirements

MEWILD runs under and follows the conventions of Microsoft Windows®. If you need to learn
how to use Windows, refer to the Microsoft Windows User's Guide. In general, if you are running

Windows,

2141

2.1.2

you prebably have the necessary system requirements to run NEWILD.
Hardware

2.5 MB minimum free hard disk space;

386 SX or higher processor,

4 MB minimum RAM;

A mouse, or similar pointing device; and

A 3 1/2" 1.44 Mb floppy disk drive.

Software
PC or MS DOS version 3.0 or higher;
Microsoft Windows® Version 3.1 or higher.

2.2 Diskette Contents

2.21

Contents of Installation Disketite

The installation diskette contains several files necessary to install NEWILD correctly onto
your hard drive. The following is a listing of the Installation diskette contents. if any of
these files are missing, the installation process may fail.

222

NEWCGO1 22
INSTALL EXE 171,952
SYSARC LZH 684,485
3 file(s) 856,458 bytes

Contents of the NEWILD Directory

After successiul installation of NEWILD, there will be a directory on your hard drive that
contains the following files.

NEWILD BAT 120
NEWILD EXE 494,080
NEWILD HLP 1,187,587
NEWILD VRF 326,983
MATRIXES VRF 451,103
BATS WLH 66
DUCKS WLH 120
OWLS WLH 78
SALAMAND WLH 102
SQUIRREL WLH 42
WOODPECK WLH 66
EZI HST 176
12 file(s) 2,460,593 bytes

2.3 Instaliation Procedures

1.
2.

3.
4.
5

Place the NEWILD installation diskette into your floppy disk drive.

If you have Windows 95, push the “Start” button on the Windows task-bar.
if you have Windows 3.1, open the File menu.

Select “Run...”

Type “atinstall”, press [
Follow the instructions given on the screen.




SECTION 3 RUNNING NEWILD

3.1 Starting NEWILD

NEWILD runs under and follows the conventions of Microsoft Windows®. After
complete installation, your Windows Program Manager will include the NEWILD
program group that inciudes the NEWILD software icon. NEWILD is by double
clicking on the icon.

3.2 NEWILD Hypertext

The hypertext is a reference section (Help) providing information about individual species, habitat
“components, use of the program, and a glossary. If you are not familiar with standard Windows

Help screens, you shouid use the Help menu selection “How to use Help” in the Windows

Program Manager.

3.2.1 Contents

This screen is the main help
screen. It provides jumping off
points to all portions of the i
hypertext. Once in the heip
system, this screen may be
accessed from any hypertext
page by pressing the A ;
“Contents” button at the top of Wildiie Species

o

kmak - Help

How to yse this program

Amphibians

the Heip window. This screen Re tfié Sl

may be accessed from the “‘Q’“*Birds

NEWILD program by selecting Wammals

“Help contents” in the Help Habitats —

menu, or by pressing []. Forest cover types
Nonforest cover types
Structural habitat features

; Habhitat breadth combinations
3.2:2 How to Use This Size class combinations
Program
i h
This part of the hypertext References

displays a picture of the main Glosoary
screen. You may click on any SEERALY

portion of the picture about Abaut this program
which you have questions. The
page may be displayed directly from the NEWILD program by using the 73 key. Most of the
instructions within this part of the hypertext are duplicated in this manual.




3.2.3 Wildlife Species

Each wildlife species in NEWILD
has a corresponding page in the
hypertext containing life history
information. The information is an
abbreviated form of the text found
in GTR-NE-108. The hypertext for
a selected species may be
displayed directly from the
NEWILD program by using the ]
key. If you cannot find a
particuiar species within the
hypertext, try using the “Search’
button along the top of the
hypertext screen.

3.2.4 Habitats

There is a hypertext page for all
habitat components. The
information is an abbreviated form
of the text found in GTR-NE-108
and GTR-NE-144. The hypertext
for a selected habitat component
may be displayed directly from the
NEWILD program by using the &J
key.

“Marten (Martes americana)

Range: Boreal forests of Canada to Alaska s. in
the Cascade-Sierra Nevada ranges, and the
Rockies into New Mexico; extreme n. Minnesota
and Wisconsin and n. New England and New York.

Relative Abundance in New England:
Uncommon.

Habitat: A diversity of wooded habitats including
coniferous forests of fir, spruce and hemlock,
dense mixed hardwood-conifer forests, cedar
swamps. Softwood dominated mixed stands
preferred in undisturbed forest in Maine. In the
Adirondacks martens are found in 30-year-old
mixed stands, and in pole and mature hardwood
stands at elevations of 530 m to 1463 m.

File Edit Bookmark Help

Eastern hemiock

Eastern Hemlock is pure or predominant over
any associate, but associates are numerous; these
commonly include beech, sugar maple, yellow birch,
red maple, black cherry, white pine, northern red oak,
white gak, sweet birch, and in northern New England,
paper birch, balsam, fir and red spruce. In southern
New England the type prefers cool locations such as
maoist ravines and north slopes; in the northern parts of
its New England distribution, warmer drier sites are
tolerated. Occurs from sea level to an elevation of 915
m in New England.

Eastern hemlock is very shade-tolerant. lts
long life span and ability to respond to release after
almost two centuries of suppression have allowed the
type to persist; early logging, and the fires that
followed, greatly reduced the occurrence of this

o Hrm..yr\n?nnl Ly = o Qﬁw




with a dotted underline is clicked, a pop-up window with a brief definition is displayed. Terms with
a solid underline will jump 1o arother area in the hypertext. The giossary may be displayed
directly from the NEWILD program by using the [2] key.

3.3 The Menu Bar

The menu bar is at the top of

the NEWILD window. It e dpppy
contains five pull-down menus: o tporied Nowd | BB
‘File, Species, Habitat, Search Hortheras Leopur :
and Help. Each of these B gt
menus are discussed below. Gy By
The underfined letter may be Erctorn Rleshicd b
L/ 2y e %

used with the [ALT] key to Iitarthers Mock of
access a menu. For exampie rended ot 2
[AL7)+[?} may be used to Eﬁ:ﬁ:?&ﬁi‘:ﬁ' ‘
display the Help menu. b Fioies 83

(Geay Fox

River olter

Marten

Fisber

Last choser species § L ast habitar seiection

3.3.1 The File Menu

The File menu can be displayed by pressing [ALT]+{ Retrieve species list
“Retneve species list” - Displays a dialog box that aNows you to | Save species list
retrieve a species list from a file. See section 3.4.2 Species Exit
Subgroups.

“Save species list” - Saves current list of species fo a file. See section 3.4.3 Saving a
Species List.
“Exit” - Quits the program.

3.3.2 The Species Menu

The Species menu can be displayed by pressing [AIT]+[£]. Modify displayed list
“Modify displayed list” - Displays a dialog box that aliows you | Save species list to file
to display a smaller list of species in the species list. Clear selections
See section 3.4.2 Species Subgroups. Search
“Save species list to file” - Saves current list of species to a T{elp on species selection

file. See section 3.4.3 Saving a Species List.

“Clear selections” - Sets all wildlife species so they are not selected

“Search” - Performs a search of the habitat features using the selections in the species list.
See section 3.6.2 Right Arrow Button,

“Help on species selection” - The hypertext on a selected species may be displayed by
pressing [7:].



3.3.3 The Habitat Menu

The Habitat menu can be displayed by pressing AT +H]. Forested habitats
The first four selections display the different habitat matrix Nonforested habitats

soreens. . . Habitat breadth
"Forested habitats” - Displays the Forested Habitat Structural Habitat Features

screen. See section 3.5.1 Forested Habitat Screen. [cioar selections

Nonforested habitats” - Displays the Nonforested Habitat g ===

screen. See section 3.5.2 Nonforested Habitat - -
screen. Help on habitat selection

“Habitat breadth” - Displays the Habitat breadth and Size class screen. See section 3.5.3
Habitat Breadth and Size Class Screen. '

“Structural Habitat Features” - Displays the Structural habitat features screen. See section
3.5.4 Structural habitat features screen.

‘Clear selections” - Clears all selected habitats for currently displayed habitat screen.

“Search” - Performs a search of the species list using the habitat seiections. See section
3.6.1 Left Arrow Button,

“Help on habitat selection” - The hypertext on a selected habitat selection may be displayed
by pressing .

3.3.4 The Search Menu

The Search menu can be displayed by pressing ALt} +T&]. Species driven
“Species driven” - Performs a search of the habitat features using Break connection
the selections in the species list. See section 3.6.2 Right Habitat driven

Arrow Button. Search summary

“Break connection” - Breaks the connection between the species list

) . Print report
and habitat features. Allows new selections to be made after a P P

Printer setup

search has been performed. See section 3.6.3 Break Arrow
Button.

"Habitat driven” - Performs a search of the species list using the habitat selections. See
section 3.6.1 Left Arrow Button.

“Search summary” - displays a summary screen of search results.

“Print report” - Prints report of search results. A search must be done before a report can be
printed.

“Frinter setup” - Sets printer options.

3.3.5 The Help Menu

The Help menu can be displayed by pressing AT} +F]. F1 Help contents
“Help contents” - The Hypertext contents screen may F2 Help on species selection
be displayed by pressing . F3 Help on habitat selection

“Help on species selection” - The hypertexton a F4 Help using this program
selected species may be displayed by pressing 7. F5 Glossary

“Help on habitat selection” - The hypertext on a Amphibian list
selected habitat selection may be displayed by Reptile list

pressing 3. Bird list
“Help using this program” - The hypertext on how to use | mammai list

this program may be displayed by pressing 4. About this program

"Glossary” - The Glossary portion of the hypertext
contains definitions of many natural resource terms. The Glossary may be displayed by
pressing #3].

“Amphibian list” - Displays the hypertext list of amphibians.

“Reptile list” - Displays the hypertext list of reptiles.

“Bird list” - Displays the hypertext list of birds.

“Mammal list” - Displays the hypertext list of mammails.



«

* name. When an animal

“About this program” - Displays source publications, citations, and authors.

3.4 Wildlife Species List

This part of the main screen
contains a list of wildiife
species. A selected species
name will be highlighted.
Species can be selected as a
result of a search using
habitat selections, or by
manually selecting a species
by clicking on an animal

tMedpeppy

[ | Red-Spotred Be

[Eastern Paisted
(Bald Eagle
iRefted Grouse
[Greg duy
iCommar Raven

T

Morthers Cardin:
IExsvere Pipistrel
|Southers Figing

species is manually selected,
a dialog box is displayed that
is specifict to habitat screen

¥ [Spotted Salamand

Hertheran Leopar

[Eastecn Blasbird

iHorthers Mockieg %
Prothesotary Warl ?};
Hooded Warbler |

&
Kid
2

%

3%

»

being used. These dialog

a5t chosen speciesth

{ Last habitat selectior,

boxes will be discussed in
section 3.5 Habitat
Features.

3.4.1 Animal Counts
| Animals [16/338) |

A box similar to th
The numbers are

is one is displayed over the wildlife species list.
the counts of selected species (either manually or

by search) and the total number of species currently on display.

3.4.2 Species Subgroups

From the Species menu, select “Modify

displayed list". This dialog box is shown to

allow you to display a subset of the entire
wildlife species list.

Modify current list - Use the current list of
displayed species, but modify it
according to the “Family groups” and
“Sort list” selections.

Currently selected species only - Display
only those animals currently selected. if
there are no currently selected species
on dispiay, this will result in no species
being displayed.

Species not currently selected - Display
only those animails not currently
selected. If all displayed species are

O Modify current list

O Currently selected species onfy
O Species not currently selected
O All avaifable species

O Retrieve list from file
[
Family groups Sort list
03 &mphibians O Phvdogenetically

O Alphabetically by first name
O Alphabetically by last name

] Reptiles
O Birds
[ Mammals

currently selected, this results in no
species being displayed.

All available species - Display all wildlife species available in NEWILD. This may be an

important choice if, by mustake, you select
being dispiayed.

one of the other cheices that results in no species

Retrieve list from file - Read a previously saved species list from a disk file (see section 3.4.3

Saving a Species List). If this option is s

elected, use the “Select file” button to browse your

computer for the desired file. When & file is chosen, its name will appear in the textbox above

this bution.



Family groups - Check the appropriate box to include Amphibians, Reptiles, Birds, Mammals, or
any combination of these families. By default, all boxes are chosen.
Sort list - Select how the final list should be sorted.

3.4.3 Saving a Species List

The current list of displayed species can be saved to a disk file by selecting “Save species list to
fiie” in the Species menu. The file will contain only the species list, no seasonal or preference
selections are saved. The list may later be retrieved by selecting the “Retrieve list from file" option
on the "Modify displayed list” pull-down menu (see section 3.4.2 Species Subgroups). Also see
“Saving a subgroup of species to a disk file” and “Retrieving a subgroup of species from a disk
file” in SECTION 4 EXAMPLES.

G A
File Species Habitat Se
B ole (367338 i

Medpeppy
Spotted Selamand.
RedrSpotted Wn
Hortheran Leopar
Eaztern Painted T
Batd Exgle
[Haffed Gresse
Grag Jug
Common Ruven
Easters Bluehivd
Weery

Movrehers Mo cking
Prothonetsry W arl
Haoded Warbles
Borthere Cardinal
Enstere Pipistredl,
Soethers Flging $

3.5 Habitat Features

This part of the main screen
contains the habitat
components. By clicking on
one of the gray tabs, you can
display habitat screens
corresponding to the four
matrices in the New England
Wildlife publications (GTR-
NE-108 and GTR-NE-144).

Morthers Figieg $
Groy Fex

River atter
[liarten

Fichar

Last chosen species | Last habitat seisction

e mres————

3.5.1 Forested Habitat Screen

Clicking this tab Search Help
displays the forested
habitat screen. This

screen corresponds
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those forested
habitats you are
interested in.
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Choosing forested habitat types:

When a forested habitat is chosen, this screen will be 0 Regeneration through seedlings
displayed. Choose the desired size classes (Uneven-aged || Sapling through poletimber

is only available for northern hardwood forest type). The [ Sawtimber

matrix assumes that stands are fully stocked, that is, they [ Large sawtimber

contain approximately 75 square feet of basal area per 3 Uneven-aged

acre.

Regeneration through seedlings - Live trees and
associated vegetation less than 1.0 inch (2.5 cm)
r d.b.h. and at least 1 foot (30 cm) in height.
Sapling through poletimber - Saplings are live trees 1.0
to 3.9 inches (2.5 t0 9.9 cm) d.b.h ; poles are live
trees 4.0 to 8.9 inches (10.0 to 22.0 cm) d.b.h. for softwoods and 4.0 to 11.9 inches (10.0
to 30.0 cm) d.b.h. for hardwoods.
Sawtimber - A stand with at least half of the stocking in sawtimber-sized trees - at least 8.0
inches (23 cm) d.b.h. for softwoods or 12.0 inches (31 ¢cm) d.b.h. for hardwoods.
Large sawtimber - A stand with a least half of the stocking in large-sawtimber trees - at least 20
inches (51.0 cm) d.b.h. for softwoods and 24 inches (61.0 cm) d.b.h. for hardwoods.
Uneven-aged - Stands of northern hardwood cover types that contain trees of all size classes.
Select all - Select all valid size classes.
Clear all selections - Clear all size-class selections. This will leave the forest type unselected
when you press Ok.

Choosing wildlife species:

When a wildlife species is selected, this - Breeding — 1 Nonbreeding

screen will be displayed. Choose the One Ono

season and the use/preferred options of Outitized Outilized

interest. The amphibians and reptiles only Opreferred Opreferred

have the breeding and nonbreeding  Breeding / feeding —  Nonkreeding f feeding
options. Holding the (AT} key when Cno Ono

selecting wildlife species will repeat O utilized O utilized

previously selected options without Opreferred O preferred

displaying this screen again.

Select all utilized - set all seasons to
"utilized", This will include the
preferred habitat as well as the
utilized.

Select aff preferred - sef all seasons to
"preferred”. The suitability (quality) of each community type for a given species was
based on ratings by wildlife experts, and on the field experience of the authors of the New
England Wildiife publications (GTR-NE-108 and GTR-NE-144). Although they are
subjective, they represent the best estimates currently available.

Clear all selections - set all seasons to "no". This will leave the animal unselected when you
press Ok.

11



352 o forested Habitat Screen

: ¥ = BRI N ERaRe N
Chck:ng this tab File Species Habitat Search Help
displays the —
K - | g wnlncorts.
nonforested habitat Y emeniadl] 8 babivars
i Swaing o

screen. This screen Slitl:ﬂ e [ Terrestrint || Wetlund { Deep || Other
Corresponds to :“"“‘"" - rUpland ———— rPalustrine rOther
Appendix B in GTR- ':“.:'::‘:‘:‘::::‘ gzmtir.ted gg:dze ltido: g‘s-&:ble b?;:

Spotted randpiper VBEE ailow wmers edge, <
NE-144. Select those a:ottlrou o OF asb ODeep marsh OCave

_ B g
habitats you are ;‘_;"- bravn myasic OSheub ? old ficld| [IShrub swamp | |0Stucture. building
: . ol o 08 ODercli itd.. debri
interested in. When e rn fpereeetie et OPan sestise buld, St

" L iq brusn b ‘Other Ll L L —
choosing a wildlife Bocver o "
) eiak aranns Lacustrine
species, the same River ateor DOrchued Lﬂ_tss_e_,.]
dialog box used for E:','E:_,, gﬁ;;‘i‘::"‘" Rirerine
H ickeral Frm TEHE

the For?Stde.d ?abitjt Sputtsd uvt'la
screen is dispiayed. Bug tastio

Wond turtie
See the paragraph Pickarsl fraq
entitled “Choosing sty

a1 ane PR ]

wildlife species” in Last chosen species ] {2zt habitat sclection

section 3.5.1 above,
for a discussion on selecting wildlife species.

3.5.3 Habitat Breadth and Size Class Screen

ckin this tab File Species Habitat Seagc Helg
displays the habitat [CHeimeir 3633y ] M2
breadth and size bt s atemende
class screen. This

Fauing wrifs

rHHabitat Breedth

screen correspond Fres vertte DForest anly

nce R ESp. S CG——— Y OF orest-Krummheolz

{o Appendlx Cin Burthorn uatos snal OFerest-Krunaholz-Bonforest
Seotted randpizar OForest-Krumshelz-Bonfore st-Water

GTR-NE-144. Select
those combinations
you are interested in.
There is no seasonal
use or preferred/

tar shess

Livels Bemuss mrntis
SiBesr-hoired ket
Eartors ipactreliie

OForest-Bonforest
OFerest-Bonforest-water

OF arest-Water

OHonforest only
OMerforest-Krummholn-Water
OMonforest-Water

Owater only

utilized informatior_w Wink fare “Sive clacres T
associated with this Fickesctfona 08-8p-Se-L Sp = Sepling/Pole
matrix, SO Cﬁcking on ::::'!':::h gg;?sp;_s: St = Smsil Sn-finbes
an animal name Pickorl frae os-se-L L=borge Sawtinber
simply selects or i os-se

unselects a species. Lazt chogen spacies [ Lact habitat zclection

12



Choosing habitat breadth combinations

When a habitat breadth combination is chosen, this screen
is displayed. Choose the desired forest type or non-forest
type (not all selections are available for some

combinations).

Deciduous forest - This selection is available only for
combinations including Forest.

Coniferous forest - This selection is available only for
combinations including Forest.

Upland nonforest - This selection is available only for
combinations including Nonforest.

Wetland nonforest - This selection is available only for combinations including Nonforest.

Select all - Select all valid options.

Clear selections - Clear all selections. This leaves the combination unselected when you press

Ok.

ol

Clicking this tab
displays the structural
habitat features
screen. This screen
corresponds to
Appendix D in GTR-
NE-144. Select those
habitat features you
are interested in.

3.5.4 Structural Habitat Features Screen
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Choosing wildlife species
When a wildlife species is selected, this screen is displayed.

Choose the season and the use/preferred options of interest. The
amphibians and reptiles only have the breeding and nonbreeding

{winter) options. Holding the A7)
species will repeat previously selected options without displaying

this screen again

=L

Season
{D Breeding

[0 Breeding / feeding

key when selecting wildlife 7 Nenbreeding
{0 Nonfreeding / feeding




3.6 Performing Searches
Searches may be done using the
selections on the habitat screen
(use the Left Arrow button) or
using the selected wildlife species

[Eastern Painced Tef

(use the Right Arrow button). If o U
poth the Left Arrow button and e g sen
Right Arrow button are green, no Eastern Blachic
vy

search has been performed and rthars Wocki

. . rothonotary W:
there is no connection between ooded Warbler
the screens. After a search is E.,::.'.‘."p;’a;:f:
performed, one of the arrow }..Z:::Ii: Fiying 10
buttons will no longer be green, e
New selections are not allowed [Harten
until the Break Arrow button is .

Last chosen species § Lastnabiat selection

pressed. Selection of another
habitat screen is not allowed unless both arrow buttons are green. So long as the connection
between screens is maintained (only one of the arrow keys is green), the “Search Summary”
screen can be displayed by selecting “Search summary” in the Search menu.

3.6.1 Left Arrow Button

This button is used to select the species that correspond to the habitat selections. When a
' search is done from the habitat selections, this button stays green, but the Right Arrow

button does not. You may review, but may not change, the season and preference screen for a

species by clicking on the desired wildlife species. You may break this mode by using the Break

Arrow button, or by making a new habitat selection.

Before the search is started, a dialog box may be displayed with search filter options. These
search filter options are different depending upon the habitat screen currently on display. The
filter selections can be used to restrict the search to desired seasons or preferred/utilized options.

if the Left Arrow button is not green, a search has been done from the wildlife species selections.
You may not make new habitat selections until the Break Arrow button is pressed.

3.6.2 Right Arrow Button

This button is used to select the habitat components corresponding to the selected wildlife
"~ species. When a search is completed, this button stays green, but the Left Arrow button
does not. You may review, but may not change, the habitats screen selections by clicking on
habitat selection. You may break this mode by using the Break Arrow button. If new species
selections are made, the Break Arrow button will be pressed automatically.

If this arrow is not green, a search has been done from the habitat selections. You may not se!ect
any wildlife species until the Break Arrow button is pressed.

3.6.3 Break Arrow Button

[mex] This button breaks the connection between the wildiife selections and the habitat
selections. When a search is performed, one of the above arrow keys will no longer be

green. This indicates that selections may be reviewed, but may not be changed. Pressing the

Break Arrow button allows you to make new manual selections or to do other searches.
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3.6.4 Search Summary
When a search has been successfully

completed, a screen similar to this one is Number of amphibians: [
displayed. A separate count of amphibians, Number of reptiles: [
reptiles, birds and mammals, as well as the total Num:;";?i: :;?:;;{:E %
number of speci is di . "
species selected is displayed. These TOTAL: [

counts only include the species currently
displayed in the species list, which may not
necessarily be all the species available in
NEWILD. Although not shown here, the screen
also displays the number of habitat components
that were selected. A hard-copy report can be
produced by using the “Print report” button. See
section 3.6.5 Printing Reports. Clicking the “Ok” button hides this screen. So long as the
connection between screens is maintained (only one of the arrow keys is green), this screen can
be displayed again by selecting “Search summary” in the Search menu.

Humber of species included in search:
Total number of species in NBEAILD: ]

3.6.5 Printing Reports

Once a search has been performed, a printed report may be obtained by selecting “Print report” in
the Search menu, or by pressing the “Print report” button on the “Search Summary” screen. The
first page of the report contains the same summary information displayed in the “Search
Summary” screen. This page also lists the meaning of any symbols or abbreviations used in the
detailed pages. The detailed pages list the selections made and the search results.

§ecws )‘_jti»tu Seq;ch He|2
m =,

3.7 Species and Habitat
Selection Windows

There are two text windows

|

at the bottom of the screen.
One displays the name of
the last chosen wildlife
species, the other shows the
last habitat selection.

3.7.1 Last Chosen
Species:

When a wildlife species is
chosen, its name appears in
the bottom left window. The
hypertext entry for this
species will be displayed if
you select “Help on gpecies

[Red-Spettcd Be ;‘,
[Hasthosan Leapard)
[Easters Painted
Baid Evgle
Reffed Grouse
(Gray Jag
Common Raven
Fasters Blochis
Yeary

Bortbers Mocki
[Prethasotury W
Hooded Warbier
Hortbere Oudh

River oster
Wbarken
fiﬂ‘ i

£1 st chosen species

¥ Lasthabkat selection

selection” from the Help menu or press 7.

3.7.2 Last Habitat Selection:
When a habitat component is chosen, its name appears in the bottom right window. The
hypertext entry for this habitat component will be displayed if you select "Help on habitat selection”

from the Help menu or press 3.
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3.8 Sash

A sash separates the Wildlife
species part of the screen from
the Habitat part of the screen.
You may move this separation by
dragging it with the mouse. Many
of the species names are quite
long, and by dragging the sash to
the right, their full names can be
displayed. However, this will
leave less space for the habitat
screens.
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SECTION 4 EXAMPLES

4.1 Using a Wildlife Species to Find Habitat Components
Example: Find the preferred breeding forested habitat for the Marten.

1. Press the "Forested habitat” tab along the top of the habitats part of the screen. This displays
the forested habitat screen.

To clear any previously selected animals, click on Species in the menu bar and select "Clear
selections”.

h S}

3. Click "Marten" in the animal list. If the Marten is not in the currently displayed list, click the
Species menu and select “Modify displayed list”. When the dialog comes up, select "All
available species" and press "Ok" and then click “Marten” in the animal list.

4. When the dialog box appears, select "preferred” in the "Breeding” season box. Make sure all
other season boxes have "no" selected. Press "Ok".

[¢a}

. Notice that "Marten" is displayed on the bottom left status bar - to obtain a narrative description
of life history information, press 7.

o

. To initiate the search of the matrix. click the "Right Arrow" button. When the search is
completed, the "Search Summary" screen is displayed showing the number of habitat
components found. If desired, press "Print report” to send the resuits to a printer. Press "Ok"
to close the summary screen.

7. The forested habitats for Marten are checked. To see the size classes utilized within a forest
type, click on the forest type. For instance, click on "Eastern Hemlock " and the "Size class”
screen will display the utilized size classes.

Notes:

e In this example, only one wildlife species was chosen. However, you may select multiple
species for evaluation. See the example "Using Several Species to Find Habitats".

s if you are using another habitat screen, a different dialog box may appear in step 4. These
dialog boxes are specific to the matrix being used.

¢ The summary screen displays the total number of habitat components found. in the “Forested”
matrix, this includes a count of the size classes.

e Notice that the "Left Arrow" button is not green - this indicates that a search has been done
using the wildlife species. To break the connection between the screens, press the "Break
Arrow" button.

« New habitat selections on this screen are not allowed when the "Left Arrow" button is not green.

e Other habitat screens cannot be chosen when the "Left Arrow" button is not green.

« Changes in the selected wildlife species list will automatically press the "Break Arrow" button,
breaking the connection between the screens.

» The "Search Summary” screen may be displayed again by choosing "Search summary"” in the
Search menu.

e To search the other matrices. select the appropriate tab in step 1 and continue with steps 210 7.
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4.2 Using Several Species to Find Habitat Components
Example: Find all structural habitat features for all woodpeckers during the nonbreeding season.

1. Press the "Structural habitat features” tab along the top of the habitats part of the screen. This
displays the structural habitat features screen.

2. To clear any previously selected animals, click on Species in the menu bar and select "Clear
selections”,

3. Ifyou have followed the steps outlined in the example "Saving a Subgroup of Species to a Disk
File", you may want to retrieve the list of wocdpeckers following the steps outiined in
"Retrieving a Subgroup of Species From a Disk File". This is not necessary, but it will give
you a shorter list of species to work with.

4. Click on a woodpecker in the species list. if there are not woodpeckers in the currently
displayed list, click the Species menu and select “Modify displayed list”. When the dialog
comes up, select "All available species” and press "Ok" and then click on a woodpecker in the
species list.

5. When the dialog box appears, select "Nonbreeding" and "Nonbreeding/feeding”. Press “Ok”".

o

Hold the :a} key down and click on the other woodpeckers. Holding the i1 key when
selecting a wildlife species will repeat the previously selected season selections.

7. To initiate the search of the matrix, click the "Right Arrow" button. When the search is
completed, the "Search Summary" screen is displayed showing the number of habitat
components found. The structural habitat features for the selected species are checked.
Press "Print report” to send the results to a printer. Press "Ok" to close the summary screen.

Notes:

« If you are using ancther habitat screen, a different dialog box may appear in step 4. These
dialog boxes are specific to the matrix being used.

« Notice that the "Left Arrow" button is not green - this indicates that a search has been done
using the wildlife species. To break the connection between the screens, press the "Break
Arrow" button.

« New habitat selections on this screen are not allowed when the "Left Arrow" button is not green.

e Other habitat screens cannot be chosen when the "Left Arrow” button is not green.

e Changes in the selected wildlife species list will automatically press the "Break Arrow” button,
breaking the connection between the screens.

e The "Search Summary" screen may be displayed again by choosing "Search summary” in the
Search menu. P

e To search the other matrices, select the appropriate tab in step 1 and continue with steps 2 to 7.
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4.3 Using Habitat Selections to Find Wildlife Species
Example: Find the species associated with large sawtimber eastern hemlock.

1. Press the "Forested habitat" tab along the top of the habitats part of the screen. This displays
the forested habitat screen.

2. Toclear any previously selected habitats, click on Habitat in the menu bar and select "Clear
selections”.

3. 0f you want all animal species on display, click on the Species menu and select "Modify
displayed list". In the "Species subgroup” dialog box, select "All availabie species”. Press
“Ok”.

4. Click the "Eastern hemiock" on the habitat screen.
5. Select "Large sawtimber" from the "Size class" dialog box. Press "Ok".

6. Notice that "Eastern hemlock” is displayed on the bottom right status bar - to obtain a narrative
description of this forest type, press 3.

7. To initiate the search of the matrix, click the "Left Arrow" button.

8. When the "Season Use - Utilized/Preferred” dialog box is displayed, press the “Select all
utilized” button. This sets all seasons to "utilized." Press "Ok."

9. When the search is completed, the "Search Summary" screen is displayed showing the
number of wildlife species found. Press "Print report” to send the results to a printer. Press
“Ok" to close the summary screen.

10. The wildlife species associated with this cover type are highlighted. To see the seasonal use
for a species, click on the wildlife species of interest For instance, click on "Marten” and the
"Season Use - Utilized/Preferred" dialog box will be displayed. Notice that the numbers in the
box above the species list show the number of species selecied and the number of species
on display.

Notes:

e If you are using another habitat screen, a different dialog box may appear in step 8. These
dialog boxes are specific to the matrix being used.

« Notice that the "Right Arrow" button is not green - this indicates that a search has been done
using the habitat selections. To break the connection between the screens, press the "Break
Arrow" button.

« New wildlife species selections are not aliowed when the "Right Arrow” button is not green.

e QOther habitat screens cannot be chosen when the "Right Arrow" button is not green.

e If new habitat seiections are made, the "Break Arrow" button will be pressed automatically,
breaking the connection between the screens.

e The "Search Summary" screen may be displayed again by choosing "Search summary” in the
Search menu.

e To search the other matrices, select the appropriate tab in step 1 and continue with steps 2 to
10.
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4.4 Combining Searches Within a Screen (OR Resuits)
Example: Find the species associated with any of the riverine nonforested habitats.

1. Press the "Nonforested habitats” tab along the top of the habitats part of the screen. This
displays the nonforested habitat screen.

2. To clear any previously selected habitats, click on Habitat in the menu bar and select "Clear
selections”.

3. If you want all animal species on dispiay, click on the Species menu and select "Modify
displayed list". In the "Species subgroup" dialog box, select "All available species”. Press
"OK".

4. Click the selections under Riverine.

5. Notice that as you select each habitat its name is displayed on the bottom right status bar - to
obtain a narrative description of this habitat type, press 3.

6. To initiate the search of the matrix, click the "Left Arrow" button.

7. When the "Season Use - Utilized/Preferred" dialog box is displayed, press the "Select all
utilized" button. This sets ail seasons to "utilized." Press "Ok."

8. When the search is completed, the "Search Summary” screen is displaved showing the
number of wildiife species found. Press "Print report” to send the results to a printer. Press
"Ok" to close the summary screen.

9. The wildlife species associated with this cover type are highlighted. To see the seasonal use
for a species, click on the wildlife species of interest. For instance, click on a species name
and the "Season Use - Utilized/Preferred” screen will be displayed. Notice that the numbers
in the box above the species fist show the number of species selected and the number of
species on display.

Notes:

e if you are using anocther habitat screen, a different dialog box may appear in step 7. These
dialog boxes are specific to the matrix being used.

¢ Notice that the "Right Arrow" button is not green - this indicates that a search has been done
using the habitat selections. To break the connection between the screens, press the "Break
Arrow” button. .

» New wildlife species selections are not allowed when the "Right Arrow" button is not green.

o Other habitat screens cannot be chosen when the "Right Arrow” button is not green.

e if new habitat selections are made. the "Break Arrow" button will be pressed automatically,
breaking the connection between the screens.

e The "Search Summary" screen may be displayed again by choosing "Search summary” in the
Search menu.

« To search the other matrices, select the appropriate tab in step 1 and continue with steps 2 {c 9.

20



4.5 Combining Searches Within a Screen (AND Results)

Example: Find the species associated with high canopy closure (>70%), and dead and down
material, during the breeding season.

1.

-
2.

9.

10.

11.

13.

14.

15.

Press the "Structural habitat features” tab along the top of the habitats part of the screen. This
displays the structural habitat features screen.

To clear any previously selected habitats, click on Habitat in the menu bar and select "Clear
selections”.

If you want all animal species on display, click on the Species menu and select "Modify
displayed list". in the "Species subgroup” dialog box, select "All available species”. Press
"Ok”.

Click the selection ">70%" in the "Canopy" box.

Notice that the name is displayed on the bottom right status bar - to obtain a narrative
description of this habitat component, press .

. To initiate the search of the matrix, click the "Left Arrow" button.

. When the "Season Use" dialog box is displayed, make sure the "Breeding" and

“Breeding/feeding” boxes are checked, and the "Nonbreeding"” and “Nonbreeding/feeding”
boxes are not checked. Press "Ok".

When the search is completed, the "Search Summary" screen is displayed showing the
number of wildlife species found. Press "Print report” to send the results of this search to a
printer. Press "Ok" to close the summary screen.

Click on the Species menu, and select "Modify displayed list".

Select "Currently selected species only". Press "Ok". The species list now contains only
those species that are associated with a high (>70%) canopy closure.

To clear the previously selected habitat component, click on Habitat in the menu bar and
select "Clear selections”. When the “Breaking connection” box appears, click on “Yes™.

. Click the selection "Dead and down" in the "Duff-ground" box.

Notice that "Dead and down material” is displayed on the bottom right status bar - to obtain a
narrative description of this habitat component, press .

To initiate the search of the matrix, click the "Left Arrow" button.
When the "Season Use" dialog box is displayed, make sure the "Breeding” and

“Breeding/feeding” boxes are checked, and the "Nonbreeding” and "Nonbreeding/feeding”
boxes are not checked. Press "Ok".

. When the search is completed, the "Search Summary" screen is displayad showing the

number of wildlife species found Press "Print report” to send the results to a printer. Press
"Ok" to close the summary screen.
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17. The wildlife species associated with this cover type are highlighted. To see the seasonal use
for a species, click on the wildlife species of interest. For instance, click on a species name
and the "Season Use - Utilized/Preferred” dialog box will be displayed. Notice that the
numbers in the box above the species list show the number of species selected (those
associated with dead/down) and the number of species currently on display (those associated
with high (>70%) canopy closure.)

Notes:

« If you are using another habitat screen, a different dialog box may appear in step 7 and 15.
These dialog boxes are specific to the matrix being used.

 Notice that the "Right Arrow" button is not green - this indicates that a search has been done
using the habitat selections. To break the connection between the screens, press the "Break
Arrow" button.

» New wildlife species selections are not allowed when the "Right Arrow" button is not green.

» Other habitat screens cannot be chosen when the "Right Arrow" button is not green.

« If new habitat selections are made, the “Break Arrow" button will be pressed automatically,
breaking the connection between the screens.

e The "Search Summary" screen may be displayed again by choosing "Search summary” in the
Search menu.

» The printed report will include "Dead and down" in the habitat component list, but not the ">70%
canopy”. Step 11 automatically breaks the connection between screens and the program no
longer knows how the wildlife species were selected. The printed report does state that there
was a limited number of species included in the search, indicating that not all species
available in NEWILD were used.

» The steps in this example may be summarized as follows:

a) Start with a complete list of wildlife species (steps 1 to 3).

by Search using the first habitat selection (steps 4 to 8).

¢) Modify the species list to display only those selected by the search (steps 9 to 10}
d) Search using the second habitat selection (steps 11-17).
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4.6 Using Multiple Habitat Screens to Find Wildlife Species

Example: Find the species associated with large sawtimber eastern hemiock and dead and down
material, during any part of the year.

1.

Press the "Forested habitat" tab along the top of the habitats part of the screen. This displays
the forested habitat screen.

To clear any previously selected habitats, click on Habitat in the menu bar and select "Clear
selections”.

3. If you want all animal species on display, click on the Species menu and select "Modify

10.

11.

12.

13.

14.

15.

16.

i7.

displayed list". In the "Species subgroup” dialog box, select "All available species”. Press
"OK”.

Click the "Eastern hemlock" on the habitat screen.

. Select "Large sawtimber” from the "Size class" screen. Press "Ok".

. Notice that "Eastern hemlock” is displayed on the bottom right status bar - to obtain a narrative

description of this forest type, press .

. To initiate the search of the matrix, click the "Left Arrow" button. When the "Season Use -

Utilized/Preferred” dialog box is displayed, press the "Select alf utilized" button. This will set
all seasons to "utilized." Press "Ok."

When the search is completed, the "Search Summary" screen is displayed showing the
number of wildlife species found. Press "Print report" to send the results of this search to a
printer Press "0Ok" {o close the summary screen.

Click on the Species menu, and select "Modify displayed list".

Select "Currently selected species only". Press "Ok". The species list now contains only
those species that are associated with large sawtimber eastern hemiock.

Break the connection between the two halves of the screen by pressing the "Break Arrow"”
button. This will aliow you to select another habitat screen.

Press the "Structural habitat features” tab along the top of the habitats part of the screen.
This will display the Structural habitat features screen.

Select "Dead and down" in the “Duff-ground” box.

Notice that "Dead and down material” is displayed on the bottom right status bar - to obtain a
narrative description of wildlife uses of this feature, press .

To initiate the search of the matrix, click the "Left Arrow" button.

When the "Season Use" dialog box is displayed, make sure all seasons are checked. Press
"Ok",

The wildlife species associated with this cover type are highlighted. To see the seasonal use

for a species, click on the wildiife species of interest. For instance. click on a species name
and the "Season Use" screen will be displayed. Notice that the numbers in the box above the
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species list show the number of species selected (those associated with dead and down) and
the number of species currently on display (those associated with iarge sawtimber Eastern
hemiock.)

Notes:

« if you are using other habitat screens, a different dialog box may appear in step 7 and 15.
These dialog boxes are specific to the matrix being used.

e Notice that the "Right Arrow" button is not green - this indicates that a search has been done
using the habitat selections. To break the connection between the screens, press the "Break
Arrow" button.

e New wildlife species selections are not allowed when the “Right Arrow" button is not green.

» Other habitat screens cannot be chosen when the "Right Arrow" button is not green.

e If new habitat selections are made, the "Break Arrow" button will be pressed automaticaily,
breaking the connection between the screens.

o The "Search Summary" screen may be displayed again by choosing "Search summary” in the
Search menu.

« The final printed report will include "Dead and down" in the habitat component list, but not the
"Eastern hemlock". Step 11 automatically breaks the connection between screens and the
program no longer knows how the wildlife species were selected. The printed report does
state that there was a limited number of species included in the search, indicating that not all
species available in NEWILD were used.

» The steps in this example may be summarized as follows:

a) Start with a complete list of wildlife species (steps 110 3).

b) Search using the first habitat selection (steps 4 {0 8).

¢) Modify the species list to display only those selected by the search (steps 9 to 10).
d) Search using the second habitat selection (steps 11-17).
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4.7 Saving a Subgroup of Species to a Disk File
Example: Create a file containing only woodpeckers.

1. Make sure that all animal species are currently on display. Click on the Species menu, and
select "Modity displayed list".

2. In the "Species subgroup” dialog box, select "All available species”. in the “Family groups”
box, click on Amphibians, Reptiles, and Mammals to remove checks. We are fooking for
woodpeckers, it's easier to just display the birds. Press "Ok”".

-
3. To clear any previously selected animals, click on Species in the menu bar and select "Clear
selections".

4. Select a woodpecker species by clicking on its name in the species list. if a dialog box
appears, select any season. You must select something here so that the species will be
selected. Press "Ok".

5. Hold the “a.r] key down and click on the other woodpeckers. Holding the ‘«.7] key when
selecting a wildlife species will repeat the previously selected season selections.

6. Click on the Species menu and select "Modify displayed list".

7. Select "Currently selected species only” from the “Species subgroup” dialog box. Press "Ok".

Only the woodpeckers remain in the species list.
8. Click on the Species menu bar and select "Save species list to file".

9. Enter a file name (if you do not add an extension, "wlh" will be added automatically). Press
!iokli

10. To retrieve the file, see the example “Retrieving a Subgroup of Species From a Disk File”.
Notes:

e The season/preferred selections made in step 4 and 5 are not saved in the file.
= Habitat selections cannot be saved.
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4.8 Retrieving a Subgroup of Species From a Disk File

Example: Retrieve the list containing only woodpeckers saved in the example "Saving a
Subgroup of Species (o0 a Disk File”.

1. Click on the Species menu and select "Modify displayed list".

2. Inthe "Species subgroup” dialog box, select "Retrieve list from file". Notice that the "Select
file" button is now available for use.

3. Press the "Select file" button.
4. Choose the file you wish to retrieve. Press "Ok".
5. Notice that the file name is displayed in the “Species subgroup” dialog box. Press "Ok".

6. The species list contains only those species that were stored in the file.

Notes:

¢ Reading a file does not change the season use and utilized/preferred selections for a species. it
only changes the list of displayed species.

¢ |f a search has been run from the habitat components, and the connection between screens is
still valid (the "Right Arrow" is not green), the search remains valid, but the search summary,
and the printed report will include only those species on display.

e If a search has been run from the species list, modifying the displayed list will automatically
press the "Break Arrow" button, breaking the connection between the screens. This
eliminates the possibility of printing erroneous reports.

26



SECTION 5 FREQUENTLY ASKED QUESTIONS

How can the selections on the seasonal/preference screen be repeated for a list of
species?

Select the first animal and set the desired seasonal use and preference selections. After that,
hold the [ALT] key down when you select the other animal species. Holding the key when
selecting an animal species will repeat the previous seasonal/preference selections.

Is there an easy way to unselect species from the list?
Click on the animal species, when the "Season Use - Utilized/Preferred” dialog box appears,
press the “Clear all selections”. When you press "Ok" the species will be unselected from the list.
if you want to clear other animals, hold the [ALT} key down and click the other animal species. If

" you wish to clear the entire species list, use the “Clear selections” option in the Species menu.

Is there an easy way to clear my habitat selections?
Use the “Clear selections” option i the Habitat menu.

Why can't | select another habitat screen after making a search?

When either the “Right Arrow Button” or the “Left Arrow Button” is not green, a search has been
performed. You have the opportunity to review the results of the search. To break the connection
between screens, press the “Break Arrow Button”.

How can | combine results of searches from separate matrices?
See the examples showing how results from searches can be combined. Follow the example that
most closely matches your needs.

How can | adjust the screen so that the entire species name is showing.
Use the Sash - the line that separates the species from the habitat screens, located just below the
arrow buttons. Just click and drag it to the right.

How can the animal species list be sorted?
Use the “Modity displayed list” selection on the Species menu. When the dialog box appears,
use one of the selections in the "Sort list" box.

How can | display only a list of species in my region?

Create a file containing the species for your area. Follow the same steps outlined in the example
“Saving a Subgroup of Species 1o a Disk File”. Once this file is created, the list can be retrieved at
any time by following the steps in the example “Retrieving a Subgroup of Species From a Disk
File".

What happens if no wildlife species are displayed?

An empty species list can occur for a number of reasons. For example, if you retrieved a list from
a file that contains only bird species, but clicked on "Birds" to clear the selection in the Family
groups box, no species would be listed. The first three options in the "Species subgroup" dialog
box (“Modify current list”, “Currently selected species only”, and “Species not currently selected”)
modify the current list of species. Under the right conditions this could resuilt in no species left to
display. For example, it you choose "Currently selected species only” and there are no currently
selected species, the resulting list will be empty. To display the entire list of species again, click
on the Species menu, select "Modify displayed list” and select “All available species” in the
“Species subgroup” dialog box.



Who can | contact if | have questicns about matrix search results?
The results of searches are based on matrices found in two publications: New England Wildiife:
habitat, natural history, and distribution and New England Wildiife: management of forested
habitats. These matrices were developed from research conducted in New England. They are
rot intended to be used in cther regions of North America. The authors of these publication
should be contacted regarding questions about the matrix contents. They may be reached at:

USDA Forest Service

Northeastern Forest Experiment Station

Holdsworth Hall

University of Massachusetts

Amherst, MA 01003

Telephone: 413-545-0357

Who can | contact if | have questions or comments about running the program?
Questions, problems, or comments about the installation, running, or use of the NEWILD program
should be directed to Scott A. Thomasma. He can be reached at:

USDA Forest Service

Northeastern Forest Experiment Station

705 Spear Street, PO Box 968

Burlington, VT 05402-0968

Telephone: 802-851-6774

Fax: 802-951-6368
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Thomasma, Scott A.; Thomasma, Linda Ebel; Twery, Mark J. 1998. NEWILD
(version 1.0) user's manual [Computer program]. Gen. Tech. Rep. NE-242.
Radnor, PA: U.S. Department of Agriculture, Forest Service, Northeastern
Research Station. 28 p. [1 computer disk (3-1/2 in.); user's manua!.]

The user's manual describes the use of the NEWILD computer program. NEWILD is
software developed by the U.S. Department of Agriculture, Northeastern Research
Station as part of the NED project, and ongoing effort to develop software tools to
support Ecosystem Management decision making. NEWILD can be used to determine
which of the 338 species of vertebrates in New England may be found in particular
habitats, or which habitats are preferred or utilized by a particular species of wildlife.
The object of this program is to assist in the access and evaluation of the information
presented in the Species/Habitat matrices developed by Richard DeGraaf, Deborah
Rudis, Mariko Yarmasaki, William Leak, and John Lanier (GTR-NE-108, GTR-NE-144).
Some of the text from these publications have been incorporated into the hypertext
portion of this program. NEWILD was designed for use in conjunction with these
publications. A diskette containing the NEWILD program is included with this
manual. The program requires Windows 3.1 or later to operate.
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